PARAGON Technologie GmbH, Systemprogrammierung

HEIXIENID Heinrich-von-StephanStr. 5¢; 79100 Freiburg, Germany

SG Paragon

Tel. +49 (0) 761 59018201, Fax +49 (0) 761 59018130

Internet www.paragon-software.com, Email sales@paragon
software.com

Virtualization ManagerA 2010

User Manual


http://www.paragon-software.com/
mailto:sales@paragon-software.com
mailto:sales@paragon-software.com

Contents

a1 goTo [UTo!1To] o H OO PPPPPPPPPPPPRY”
FRALUIES OVEIVIEW. ..c.ceiiiiiiiee ettt r et e et e e e e e e e e e e e e e ameaeeeaaaeee e e 4
(N ST LU S PP EUP PP 4
10 o] olo] ¢ (=To B W=Tol p] g To] (oo =1 PP PP PP P TP PPPTTRTUPTRRRRN 5
Supported Virtual MACRINES. ........oooiiiiiieeee e e e e e e e e e e 6
SYSIEM VIMUANZATION .......cceeiieie et e e e e e e e e e e e e e e e e e s i e e e e e e e e 7
ATAY A Lo (oY 2 @ 0] o 1] 0T U= 1 | £ PSPPI 8
INTEITACE OVEIVIEW......oiiie ettt ettt ettt ettt ettt et e e e e st m s e e e e e e e e e e e e e e e e e e e e eeeeeeameees 8
GEINETAI LAYOUL.....co ittt e et e e oo ekttt e et e e sttt s e e e e e 244 AR b b e e et e e e e e ab bbb e e e e e e e e annbbne e e e e e e e nnbbnneeaeeas 8
Y= UL I\ =T o O TP PP PPPPPPP 9
LI L] =2 T PP PR PPPPPR O 12
AV R @ o LT el 1o g = PSP P PP PPEPP R PPPPPPPRRPT 13
COMIMON TASKS BAT.......eeiiiiiiiiiiie ettt e e e e e ettt e e e e e e et e e e e e e as bbbt e e e e e e e an s bbb e et e e e e e anssbbn e e e e e e e annnbnnees 13
D1 Y =T o F TP PPPP PSPPI 14
g o (o= gl =T OO PP PP PPPPPRRPPP 15
e LU I N I TSP PP P PPPPPRRPPP 17
[ITo =T ol =T TSP P T TP PP PPRPPPROP 17
Y= UL S = T TP TP PP PP PP PPPRPPPPRPPP 18
Y=L 0T S @Y T V[ TSP 18
(€Tt TcT = I @] o] 1 o] o 1 TP POPPPPPPPPRN 18
e Ta U1 (o] 011 g T I @ o] 1] o < TSP PPP P PPPPTPP 19
General Copy and BaCKUDP OPTIOMS. .....ceiiiuiiiiiiie e eeeiit et e ettt e e e s s e e e e e e e b bt e e e e e s as bbb e e e e e e e e asbbeeeeeeeeennnees 20
HOU PrOCESSING OPTIONIS ... iiiiittiieii e ettt e e ettt e e e e oottt e e e e e s s bbb e et e e e e s e st abe et e e e e e e annbb e et e e e e e e ansbene e e e e e e e annnnneeeeas 20
=TT @ o110 PP PPT O PPPPPPPPPN 22
Operation DEPENUENCY OPLIONS ... ..uuiiiiieiiiitieeieee e e ettt e e e e s et e e e e e e e be et e e e e e s s bbeeeeeeesaasbbbeeeeeesaansbsneeeeeeeansnees 23

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.



VAL Y oTe [ @] o] i o] o =P PP PP PPP 23
File SyStem CONVEOBT OPTIONS......eeiiiiiiiiiiiiie e ettt e e et e e e e s s e e e e e e s s s b s e e et e e e e s s s e e e e e e e e s e nnrer e e e e e e s annnnnneeens 24
(oo [ 1[I O o] 1T0] o I TP PP PPPPRPP 25
TYPICAI SCENANOS. ....ceiiiiieeeeee ettt e et e e e e e e e e e e e e ame e e e e e e e e e e e 26
System Mgration and Virtualization SCENAIOS. ........uuuiiiiririiiiiiiiieraaa e e e e e e e e e e emeee e eeneeaeeeanaaes 26
Migrating system to another hard disk (Clone HDD)............oooiiiii e e 26
Virtualizing the CUITeNt SYSIEM 2R )......cco oo e e e e e et et e e e e aaeaeeaeeaeeeaeesseassaasaassnnnnnennnrnrens 28
Virtualizing system from its backup iMAge (P2V)........uuuuiiriiiiiiiiiiiiieieir et e e e e e e e e rreeees 31
Making system bootable on virtual hardware (P2V AdjUSLQOS) ....uuuiiiiiiiiiiiiiieeee e 35
Connecting a virtual disk (CONNECE VD). ....uuuuiiiiiiiiiiiiiiieree et e e e e e e e e e e e e e e e e e e s e e s e e e e e e e e aar e e brereerraeseeeeeeeeees 36
Repartitioning @ VUL iSK..........uuuuieiieiieeeee e e e e e e e e e e e e e e e e e 38
Exchanging data between physical and virtual eNVIrONMENLS................oooovieiiiiiciiiiciinrinnnrierrreesreeeeeeeeeeeeeeeeeenn . 40
Copying data from a parent virtual disk to one of itS SNAPSNALS..........uuiiiiiiiiiiie e 42
Migrating from one virtual environment t0 aNOINEN (V2V))....uuueiiiiiieiiiiieeeee e 42
Making system bootable on different hardware (P2P AdjuSt.QS).......cuvmiiiiiiiiiiiiiiiieeeeeeeeeeee e, 42
Migrating from a virtual environment to PhYSICal (WV2R).........uuiiiiiiiiiiiiiieeee e 44
Migrating @ WINAOWS 7 VR........uuiiiiiiiiiiieiieeeeieeeeeeee ettt r s rrrressreseeeeeeesenseeasaneeeee . 4D
EXtra SCENANOS fOr WINPE........oeiiiiiiiiiiiiii ettt e et e e e e e e e s m bbb e e e e e e e e e e aans 45
Yo (o T To IR oL | T oo [ )Y € PPPPPPPRPRR 45
ConfiQUIING NEIWOIK .....ooiiiiiiiiiee e e e e e e e e e e e e e e eaaeaaeeeeaaeseessssesssnsssssssnnnnsnnssssesnesss O
ST= 1Y Lo T To I 1= PSSO PPPOPP A48
Connecting Virtual Disks to a Virtual MacChine...............coiiiiiiiiieieee e 48
Connecting virtual disks to an existing virtual Maching...........c.cccoc 48
Connecting virtual disks to a New Virtual MaChINE. ... ..o 51

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.



Introduction

More and more people today face the problem of smooth and cost saving system migration. It mostly has to do with
constant hardware improvement. Traditional approach involving completenstallation and resetup of the operating
aeadsSy FyR Ffft LIWIXAOFGAZ2Yya NBldzANBa | f2d4 2F GAYS |
software will flawlesgl work on a new hardware platform.

t I N} 32y + A NI dzl 2010is hnlefegant solutioythaBcaMdelp you accomplish the following tasks:
1 Migrate a Win2K+ physical system to a virtual environment in the online rfRizié);
1 Migrate a Win2K+ physical system backed up with a Paragostelisacovery tool to a virtual environment
1 Migrate a Win2K+ virtuaystemto a physical environment (V2P);
1 Migratefrom one virtual environment to another (V2V)
1 Migrate a Win2K+ physical system to a different hardware plati@2P);

f ConnectavirtuaRA ai1 +Fta AF AGQa Iy 2NRAYINEB LKe&aaolft
disks to virtual (Connect VD);

¢
>
QX
—

1 Recover the startup ability after unsuccessful virtualization with a 3rd party, tool
1 Recover the startup ability after unsuessful system migration to a different hardware platform

In this manual you will find the answers to many of the technical questions, which might arise while using the prograr

Our companyis constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

Features Overview
This chapter dwells upon key benefits and technical highlights of thdugot.

Key Features
Let us list some of the key features:

1 P2V Copyo migrate a Win2K+ physical system to a virtual environment in the online mode

1 P2V Restoreo migrate a Win2K+ physical system backed up with a Paragon disaster recovery tool to a virtual
environment

 ConnectVhoc2yySOUG I @ANIdzZf RA&]l & AT A0 Qtiohajty aaldRla y I
for physical disks to virtual

1 P2V Adjust O® recover the startup ability after unsuccessful virtualization with a 3rd party tool.
1 P2P AdjusDSto migrate a Win2K+ physical system to a different hardware platform

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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1 P2P AdjusODSto recover the startup ability after unsuccessful system migration to a different hardware
platform.

9 Support for major virtual machinesMicrosoft Virtual PQylicrosdt Virtual Server, Microsoft Hyper, VMware
Workstation, VMware Fusion, VMware ESX Server, Sun VirtualBox.

1 Smart Driver Injectoto make the process of adding@w drivers smooth and easy

1 Easy size setup for virtual diskgth the partition autoresize option.

1 2 types of virtual drives for VMwaré¢o create either an IDE or a SCSI disk.

1 Disk file split for VMwarego automatically cut the resulted virtual image fites of 2 GBs each.

91 Partition/Hard disk copyto successfully transfer all etisk information including standard bootstrap code and
other system service structures, thus maintaining the opergt3 & & & (i Scdmglitys 2 NJ A y 3

9 Eile Transfer Wizartb make such operations as transferring of files/directories or burning of them to CD/DVD
aseasy and convenient as possible.

1 Merge Partitions Wizardo consolidate the disk sjga, which originally belongs to two adjacent partitions
(NTFS, FAT16/FAT32), into a single, larger partition.

1 Redistribute Free Space Wizatalincrease free space on one partition by-iaking the ondisk unallocated
space and the unused space of othertjins.

1 Convert a file systenfFAT16/32, NTFS, Ext2/Ext3) without reformatting.

1 Modify file system parametergmake active/inactive, hide/unhide, change serial number, partition ID, volume
label, etc.).

1 Basic functions for initializing, partitioning anfbrmatting hard disks(create, format, delete). Instead of the
standard Windows disk tools, the progranpgorts all popular file systems.

1 Undelete Partitions Wizardo recover an accidentally deleted partition.
1 27 defragmentation strategieavailable to @fragment FAT and NTFS file systems.
1 MFT defragmentation and shrinkingp improve performance of NTFS.

9 Scriptingto make the program create a script of any set of operations you need. Besides support of all
operations available in the interactive mode, theattended mode provides some additional features, such as
conditional execution, subroutines, repeatable iterations, disk/partition propertres\asis, errors
management, etc.

1 Task schedulingp automate routine operations. It can be particularly efigetwhen you have to repeat a
sequence of actions on a regular basis.

A Scheduling is only available for the Windows installation of the program.

Supported Technologies
/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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Along with ushg innovative technologies from outside, Paragon has developed a humber of its own original
technologies that make its products unique and attractive for customers:

9 Paragon Hot Copy technology to clone locked partitions and hard disks under Windows &tiityfoperating
systems providing both high operating efficiency as well as low hardware requirements.

T tFNJF3I2y ! RI Lischndl8gy tesSciabstulidnigrate a Win2ighysicalsystem to a different
hardware platform (P2P)

T tFNF3I2y t 2 eSnlody © préviddata consistency in case of a hardware malfunction, power
outages or an operating system failure.

T t I NI 32 ytechrolpgy to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

 Parad2y | 2 { teenBolodyito@marge NTFS partitions (system, locked) without rebooting Windows and
interrupting its work.

t NI 32y { YI tedhnolbdy dISekuiely pefform hard disk partitioning operations of any complexity.

=

9 Paragon VINKk (Virtual mage Management) technology that enables Paragon products work with virtual disks
as though they are physical hard disks.

1 Microsoft Volume Shadow Copy Servifé¢SS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2008)08 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on alsoafxhnology concept.

1 Microsoft Dynamic Disksimple, spanned, striped, mirrored, RAPto offer more management flexibility
without the patrtition limitation of basic disks. Dynamic storage can be particularly beneficial foiskzatze
businesses whedealing with many physical hard disks involving complex setup.

1 GUID Partition TabléGPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, S¥I8eMac OS X and Linux.

Supported Virtual Machines
t I N} 32y =+ A NI dzI 2080préviilds Buppora for yhijat Briudt machines presented on the market today:

1 Microsoft Virtual PC;

I Microsoft Virtual Server;
1 Microsoft Hype+V;

1 VMware Workstatio;

1 VMwar Fusion;

1 VMware ESX Server;

M Sun VirtualBox;

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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)l
T
)l

MS Windows Vista/7 backup;
Parallels Workstatian

XenServer (.vhd only).

System Virtualization

With new powerful x86 computersystem \rtualization has become extremely popudar L (i @vare téchnal@g that
enables to rurseveral virtual machines on opdysical machingyrovidingresources of that single computare shared
acrossseveralenvironments As a result one and the same physical computer can have multiple OSs and applications
operating simultaneous/ythus opening ugnormousopportunities for both businessand home usersexactly

T
)l

)l
)l

Avoidunderutilization of upto-date powerful computers;

Increase flexibility of a physical infrastructure;

Provide for increased availability oitdware and applications;

Cut expenses on hardware and energy;

Guarantee smooth and cost saving system migration;

gya22e g2NJAYy3 6A0GK 2ftR | LILX AOFGA2ya @2dz OFyQd €I
Take advantage of having multiple operating systems on one Windowmsdhdeling Linux, Mac OS X, etc.;

C2NHSG I02dzi KdzyGAy3a F2NI NBLX I OSYSyld 2F GKS Tl At

Known Issues

1.

You should install integration services (e.g. VMware Tools) on the virtual system yourself. We only guarantee
smooth startup.

Atthe startup a virtual machine (e.g. VMware Workstation) might notify you that the used virtual disks are of
old format and require update. You can update your disks, since this procedure involves change of a version
only, nothing else. This is done onrpasenot to lose compatibility with the older versions of VMware.

After transferring Microsoft Vista and later versions to a virtual disk, you will needdotieate license of the
adaidsSyo LGQa y2NX¥If 0SKIF@A2N | fhardwkrE Réctivatdraisilégaia 1 S
justified in this case, as you transfer your system to another PC.

If you prefer to create a SCSI HDD when converting to a virtual disk of VMware Workstation or VMware ESX
Server, we pick a driver for the HDD controjiest the way VMware does, i.e. according to the found OS:

1 Windows 2000/Windows X@Buslogic;
1 Windows 2003 (all editions including WinXP x64) and later vergib8$ Logic.

Thus if you will then connect the created virtual disk to a virtual machineamitither type of the adapter, the
a2aidsSy ¢2yQi adl NI dzlJd t€SFaAaS dzaS 2dzNJ t vt ! Radza i

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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5. If you convert a partition/hard disk with Windows XP to a SCSI virtual disk of VMware Workstation or VMware
9{ -z A0Qa WSl daMBRBIT/{RRRNAGSNI FNRY 2dziaARST aA
try to find an installed version of VMware Workstation on your computer to extract the necessary driver. If
failed to find, we will ask you to provide a path to the VMwam®ls 1ISO image.

6. We can smoothly convert a hard disk with several operating systems. But accordisgea} when converting
to a SCSI virtual disk of VMware Workstation or VMware ESX Server, for different versions of OS, different
controller drivers wilbe installed. VMware however cannot emulate different hardware for each operating
system of one virtual machine. To tackle this issue, please use our P2P Adjust Wizard to install the LSI Logic
driver under Windows 2000/Windows XP, then select the LSIc®86t®oller for your virtual machine.

Windows Components
In the given section you can find all the information necessary to successfully work with the Windows version of the
product.

Interface Overview

This chapter introduces the graphical interface af grogram. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems ¢dtaocur while managing the program
can be tackled by reading this very chapter.

General Layout
When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards ar

dialogs, to specify program settings, \tisualize the operating environment and the hard disk configuration.

'da™y

¢KS [ dzyOKSNRA& 6AyR2g Oly 0SS O2yRAGAZ2Yylffe& adzowRAODAR
functionality:

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.



""' Welcome 1o I-"aragnn Yirtvalization Mas=~~="™ A [ain Menn
Todls Changes ‘Wizards HardDisk Partkion Yiew Help

Help
Vutualization T) |
@1 r2v oy
Volume letter: (] Serial numbes:
(% F2vResioe Volume label: System Parition 1D: (7 HIFS
Type: Presy HTFS westion: 100
File system: NTFS Volume Size: 195 GE
B eovaduacs Root entiies: 87235 Padition size: 135 GB
Sectors per book: 8 Used space: 176 GE
Seclors per clusler: § Free space: 1668
Activity: Ves
Hidden state: Mo
Move/Aesize Partition Explorer Bar
Fresize of Move partition. -

Eormat Partition
Thiz wazaed balps pou Lo foemat the pelacied paition
Waining: Formmalting vall ecass ol the datas on the padiion |

Thiz vazaed el you lo dedebs the selacled paibion

9 Connect & Virhual Disk A e e L e NN e o P —

Dizk Map
¥ Fie Tianderwieard .

Basic Hard Disk 0 Maxtor 7YZ50P0)
Second HOD [F:) DiskAkap
2337 GB NTFS

Help and Document ation

{‘_ Wirtuskzahion M anage™ Help Basic Haid Digk 1 [STI160E15AS)

Qi - Spatem [C:] hanlications (0] l Diher Stulf [E:}
About Wtuskr steor M ansged
19568 NTFS Legend Bar BEGE HTFS
& sciotManua - -
W OHIFE W AT N Lirnx B2 Liruzs Ew3 Lirns Esad Feiafs W Apo
Status Bar P 5

i Mo changes.

1. Main Menu
2.Tool Bar

3. Virtual Operations Bar

4. Common Tasks Bar

5. Explorer Bar
6. Disk Map
7.Legend Bar

8. Status Bar

A number of panels offer similar functionality with a synchronized layout. The progmabies to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layc

Main Menu
The Main Menu provides access to the entire functigpalf the program. The available functions are as listed below:

/ 2 LJ& N 3 R@08 Paragnd Software Group. All rights reserved.
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MENU ITEM FUNCTIONALITY
Tools
6EAx ,1CO8 View logs on the carried out operations

Send Log Files

Compress and send the log to the Paragon Support Team

&EIT A 40A1T OAFAO

Transfer data from any media

Settings... Edit the general settings of the program
Exit Exit the program
Changes

AT AOAOA 3 AOESB

Generate a script for the task

3A0A O1 3AEAAQ

Schedule pending operations

Undo “the last virtual
operation®

Cancel the last virtual operation on the List of Pending Operations

Redo “the last virtual
operation®

Cancel the last undo virtual operation on the List of Pending Operations

6EAx H#EAT CAOS

Display the List of Pending Operations

Apply Changes

Launch the real execution of virtual operations

Discard All Changes

Cancel all virtual operations on the List of Pending Operations

Reload Disk Info

Refresh the current information about disks

Wizards

# OAAOA 0 AOOE OH Create a partition of any file system
&1 O AO 0 AOOE OH Format a partition of any file system
$A1T AOA 0 AOOE OH Delete a partition of any file system

51 AAT ACGA 0AOOEH

Recover an accidentally deleted partition

- AOCA 0AOOEOEI

Merge adjacent partitions of NTFS, FAT or FAT32 file systems

2AAEOOOEAOGOA &

Redistribute available disk space of existed partitions

0co ! AEOOO [/ 38

Make your system bootable on different hardware

0c6 #1DPUS

Migrate a Win2K+ physical system to a virtual environment in the online m

0c6 2AOO0T OAS

Migrate a Win2K+ physical system backed up with a Paragonetisasovery
tool to a virtual environment.

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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0¢c6 ! AEOOOS

Recover the startup ability after unsuccessful virtualization with a 3rd party

tool

#1 PU (AOA $EOEH

Create a hed disk copy

#1 DU O0OAOOEOET I

Create a partition copy

Hard Disk

Update MBR

Update MBR (Master Boot Record) of the selected hard disk

#EAT CA O0OEI AOU

Modify the primary partitions enumeration for the selected hard disk

WAEOT6EAXx 3AACQ

View/edit sectors of the selected hard disk

Connect a Virtual Disk

I 2yyS0G I GANIdzZ t RAA]l G2 62N]

g A

00T PAOOEAOS

Get indepth information on the properties of selected hard disk

Partition

# OAAOA 0 AOOE OH Create a partition
&1 Of AO 0 A OOE OH Format a partition
$ A1 AOGA 0 AOOE OH Delete a partition

-1 OAT2AOEUAS

Move/Resize the selected partition

#11 OAOO &EI A 3

Convert file sygm of the selected partition

Il OOECT $OEOA

Assign drive letter to the selected partition

2AT T OA $OEOA

Remove drive letter for the selected patrtition

(EAA O0OAOOEOEIT

Make the selected partition unavailable for the operating system

Unhide 0 AOOEOET T 8

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition nchootable by default

#EAT CA #1 O00O0A g Changeluster size of the selected partition
#EAT CA 611 O A | Change volume label of the selected partition
#EAT CA 3 AOEAI | Change serial number of the selected partition
# EAT CA 0 AOOE OH Change identifier of the selected partition

Downgrade N4 & 3 OA O

Decrease version of the selected NTFS partition

#EATCA 3) 88

Change SID (Security Identifier) value of any found Windows installation

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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-AEA 0AOOEOE

Make the selected partition Primary

-AEA 0AOOEOE

Make the selected patibn Logical

$ AEOACIT AT O 0 A { Defragment data on the selected FAT or NTFS partition
$ AEOACIT AT O - & 4| Defragment MFT (Master File Table) of the selected NTFS partition
#1 1 PAAO - &48 Shrink MFT (Master File Table) of the selected NTFS partition

Test DOALAAAS

Test surface of the selected partition/block of free space

Check File System
) T OACOEOUS

Check the selected patrtition for possible file system errors

%AEOT 6 EA x

3 A A § View/edit sectors of the selected partition

001 PAOOEAOS

Get indepth informaion on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Displaythe Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location

Select whether the Disk Map will be located on the top of the main window
at the bottom

Help
Help Open the Help system (you can also do it by pressing F1)
About Open the dialog with information about the program
The Main Menu contents available at thmoment may vary depending on the selected
object.
Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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TN Connect a virtual disk
T

5’@2 Open the Help system
\g

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operaticaieso
virtual mode of executio). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALY

z’-_\”_—'j Cancel the last virtual operation on the List of Pending Operatior
@”‘\ Cancel the last undo virtual operan on the List of Pending
Operations

Display the List of Pending Operations

QP Launch the real executioof virtual operations

% Cancel all virtual operations on the List of Pending Operations

Virtual mode isan effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance
weigh all pros and cons of this or that particular operation. The program politely redsin
the user that there are unsaved changes by showing the following window:

A 1 There are unzaved changes. o

Plesse use the ﬁf"ﬁpnh command lo comire the changes and rheﬁ Dizcard
command o permanently unda the changes,

fous can view the changes history via the . View Changes command and

temporanly urda of redo the operation by means of ﬂ'ﬂ'b Undo and * Redo
commands.

Common Tasks Bar
The Common Tasks Bar is located on the left side of the main windowntétrided for easy access to the program's
wizards.

The bar contains several tabs nam\édtualization TasksCopy TasksToolsandNews and DocumentationEach of
these contains a separate button bar which can be folded by clicking it.

Virtualization Tasks

/ 2 LJ& N 3 R@08 Paragnd Software Group. All rights reserved.
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EC | P2V Copy

Starting the P2V Copy Wizard to migrate a Win2K+ physical system to a virty
environment in the online mode.

=,
[,{1 P2V Restore

Starting the P2V Restore Wizard to migrate a Win2K+ physical system backe
with a Paragon disaster recovery tool to a virtual environment.

“@ P2V Adiust 05

Stating the P2V Adjust OS Wizard to recover the startup ability after unsucce
virtualization with a 3rd party tool.

Copy Tasks

[;:i Copy Disk Starting the Copy Hard Disk Wizard tpg@ hard disk.
- Copy Partition Starting the Copy Partition Wizard to copy a partition.
Tools

}n} Connect a Wirtual Dizk

Sarting the Connect a Virtual Disk dialég connect a virtual disk to work with it
Fa AT AdQa I LKearAlOltf RA&al®

- File Tranzfer ‘Wizard

Starting the File Transfer Wizard to transfer data from any mesesides it
provides access to Paragon backups as regular folders to browse through thg
contents or copy required files.

News and Documentation

-
\ g "Wirtualization b anager™ Help

Launching the help syain (you can also do it by pressing F1).

\_fl About Virkualization Manager™

Opening the page which contains information about the program. This page
be displayed in the Explorer Bar.

k= Script Manual

Opening a brief review on the Paragon Scripting Language.

Disk Map

The Disk Map is displayed in tBgplorer Bawhen the Disk View tab is selectddis located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map

Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physias digkesented with
rectangle bars that contain smalized bars. These smalked bars represent logical disks. Their color depends on the
file system of the appropriate partition.

-

Basic Hard Disk 0 (VMware, VMware Virtual 5 5CS51 Disk Dev)

Local Disk {(C:)
4359 GB NTFS

Largesized bars display the following information about physical disks:

/ 2 LJ& N 3 R@08 Paradod Software Group. All rights reserved.
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1 Manufacturer,
1 Model.
Smallsized bars display the following information about logical disks:
1 Serial number,
9 Drive letter,
1 Total size,
1 File system.

Furthermore, it is possibletoestimi S G KS dzaSR RA&{1 aL}I OS o6& t221Ay3a I
2FFSNBR (2 OK22aS8S FTNRY aSOSNI¢ GewlSa 2F GKS RAal f1l @&z
AyaaglryoOoSs AT @2 dzQgJ Sve éataining botK vied Kargeindréd tfan 1iD@ GBKdndNRheRshall (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
fAYSIEN LSS0 &2dz g2y Qi 0 S tthing tdps. Drethetfied haddYiftHe propbatiohslichski A 2
layout is critical for you, the linear type is exactly what you need.

bSOSNIKSt Saa GKSNEB Qlinealscaling Withii@ nvidini@alSimitt2stalzipaktifioyis. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

T o |

«  Limear
Limear Scaling Min Width
Loganithmic Scaling

N

Lirnee Ext4 ReiserFS

Disk Map is synchronized with the ExploBar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The dragand-drop functionality is not available when théogarithmic type of the disk
layout is selected.

Explorer Bar
The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

1 The help system;

1 General information on the produ including its name, version and a list of helpful links;
9 Detailed information about disks selected on thesk Map

9 List of scheduled operations;

9 List of scripts;
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1 Volume Explorer utility;
9 Disk Editor utility.
According tahese categories the Explorer Bar has several tabs:

9 Disk View which offers the user the following options:
- Partition Listo get a cleaicut picture of the current state of the system hard disks/partitions;
- Disk Edor to view/edit sectors of the selected partition/hard disk;
- Volume Exploreto browse and export contents of the selected partition/hard disk;

- Propertiedo view detailed information on the selected partition/hard disk in the bright graphical form.

E Youcan switch between theseomponents by clicking tabs on the left side of the Explorel
Bar.

1 Scheduled Tasksvhich gives the user the possibility of browsing and editing schddyperations and the
program scripts.

9 Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fuliynctional embedded HTML browser, iwh offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HT¥tiented. You can read it and follow erbal links from to get additional information.

Dk Wiew Seheduled Tacks Hedp

@@ % @
Saparaﬁorfparagun Virtualization Ma

SOFTWARE GROUP

Version information

Paragon Virtualization Manager™, version 2010, build 9044
(03.11.09 ) Corporate

Componeénts Versions:

Paragon B if\-‘“'\-n.-fn"!.llh? rl., rgeon
hediri.dll v 10.0, retsaza 10, buitd 10444

Eden .l L Ep BT T alaaEa I suild 10434
blont.ays, v m 1 TS balld 1 Gddd

Support links

Download Free Update

To easily navigate through browsed pages, the program provides the following functionality:
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BUTTON FUNCTIONALITY

Far) i

) Return to the previously browsed
page

P

© Open the next browsed page

o Stop loading the current page

Refresh the contents of the current
page

Partition List

The Partition List is another helpftool that enables you to get a cleaut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the contex¢ensitive popp menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,

- Volume label (if exists),

- Partition type (Primary/Extended /Logid,
- File system type,

- Size,

- Amount of used and unused (free) space,
- Start/End cylinder,

- Start/End head,

- Start/End sector,

- Free size in sectors/bytes,

- Active/lnactive attribute,

- Hidden/Unhidden attribute.

Legend Bar
The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar w

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the
Explorer Bar

The program distinguishes between the following types of known file systems:

- FAT16/32,
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-NTFS,
- Linux Ext2/84,
- Linux ReiserFS,
- Apple HFS.

Status Bar
This is the bottom part of the main window. The $&Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. Alltihgsate grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog.
selecting a section from the list, you can open a set of options.

c To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you need.

General Options

% Edit settings

¢ -
Pastiioning options ?}f General optlons
Copy and backup options

Hol processing optons [#] Enabie data lozz protection

[ Choose thiz aption to ensuie that no data will be lost i system unexpectediy
Dpetstion dependeancy ophions goes down [becauss of powes shorage eic |

Withual rmode oplions:

File gpstem corvedzion ophons

Log fles ophions

[ ok || Cawel |

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

1 Enable data loss protectiarMark the checkbox to make the program work in the-$aile modgalso referred

to as the datdoss protection mode), which ensures reliability for operations by maintaining a special journal. Ir
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case of a hardware malfunction, power outage or an OS failure happened in the middle ofsedsitive
operation (resize, mve, merge, redistribute, change cluster size, etc.), the progrdhask to insert the
bootable recovery mediand automatically complete the interrupted operation, thus reviving the corrupted
partition.

A It is strongly recommended to enable this option.

Partitioning Options

% Edit settings

G al g cep ¢ .

(7 Partitioning Options

Copy and backup options

Hol processing ophons [ ] Enable 64 KB chbers for FAT1E

[ Choose this aption to enables 64 KB chusters for FAT 16 partibons. ‘With thes
Dpecation dependency oplions zafing, wou will be abls bo create FAT1E partitions with capacky up bo 4 GB.
Virual mode opitions Plaase note that only Windows MT Famiy spstems wall be able bo access such
File system corvwedzion ophons pactiions.

Log ez aptions Confimations

Ak for volums lsbal before partition delets
] Ask confimation when convesting FAT 16 to FAT32.

[ ok || Cawel |

This section contains a set of options that will be taken into accouribg partitioning operations:

1 Enable 64 KB cluster size for FATM&rk the checkbox to enable 64KB clusters for FAT16 partitions. Thus you
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

1 Request confirmation before partition deletionMark the checkbox to astate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

1 Request confirmation when converting FAT16 to FATBRrk the checkbox to automatically request
confirmation before conveimg FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a large
hard disk with the proportional resize of existing partition$iat is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no
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way be possible to accomplish. The same goes for any copy hard disk/partition or restorésképdrtition
operation involving an extra upsizing.

General Copy and Backup Options

% Edit settings

Gerersl ophons

Parblorin cutire [?g General copy and backup options

Copy and backup option:

Hol processing ophons ] Hdd raw processing

E-mad oplicne Copy/Backup an entite haid disk sector b sector without taking into account

O pesation dependency oplicns i partition shuctuie,

Withueal reodie oplions ) .

File systenm conved 2ion oplions (] Partition raw processing

Lag fles optiors Copy/Backup each partition sector by sector, Al sectors will be processed
ore by one [even unused sectors). Requites more time to complete the
operaton.

[#] Skip 05 audisry fles

Choase this aplion 1o skip 05 suxhary fles (ke pagehie. sys. hiberhlsys stc.).
Thiz wall ischuce oparation e and backup mags size.

[ oKk || Concel |

This section contains a set of options that will be taken into account glewopy and backup operations:

1 HDD raw processingMark the checkbox to copy/back up a hard disk in the sdayesector mode, thus
ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be
processed as w8l This can help to avoid problems with hidden data created by certain applications or the
system administrator. However, it will take more time to accomplish the operation.

1 Partition raw processingMark the checkbox to copy a partition in the seelgrsector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

1 Skip OS auxiliary filedviark the checkbox to skip O8xdliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.

Hot Processing Options
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In this setion you may configure the hot processing mode:

1

Enable hot processingViark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

Hot processing technologyrrom he pulldown list you can select the required hot processing technology.

Always use hot processingelect the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

Use hot processing only whenggtition is locked Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that onc
you start any operation on a partition in this mode, it will automatichk locked by the program, thus you

won't be able to keep working with it as usual.

Hot processing temporary driveHere you can select a disk drive that will be used to store the temporary hot
backup data (by defaui C:).

Attempts to start VSSHere yu can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a specialipaobde.

Timeout between attemptg(in seconds)Here you can set a time period between diffnt attempts to start
Microsoft VSS.

Switch betweenhot processing technologiedMark the checkbox to automatically switch between Paragon Hot
Processing and Microsoft VSS if one of them is unavailable at the moment.
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